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1 Introduction
DiagSap is a tool to produce Philippine-style word tree diagrams. DiagSap is pro-

nounced diɑɡsɑp1 and is short for Tagalog diagramang sapin-sapin which means
"layered diagram.” You key in a description of the tree, process that description,
and DiagSap shows what the tree looks like. The tree can be saved in up to two
different file formats so that it can be included in papers or web pages.
DiagSap looks like what is shown in (1).
(1)

The file name where the tree information is stored is shown in the upper left part
of the window. You key the description in the top pane, process the description,
and then the tree appears in the bottom pane. Since each node in the tree has
binary branching, it begins with two lexical forms as shown, using “a” and “b” for
the forms. You change them to be what you need. We suggest starting from the
innermost forms and building the tree outward.
See section 2 for information on keying a tree description and processing a tree.
You can drag the edges of the window to make it larger. You can also drag the

bar between the panes to make either the tree display or the description larger (or
smaller).

2 Keying a tree description
You key in a tree description in the top pane. To show the corresponding tree in

the bottom pane, you "process" the description in any one of four ways:

• by clicking the "process the tree description tool bar button" ( );
• by clicking on the Tree menu item and then Draw Tree;
• by typing Ctrl-D (holding the Ctrl key down while pressing the D key); or
1As opposed to daɪæɡsæp.
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• by using the Settings menu item / Draw tree as you type option. This will draw
the tree for each keystroke you use in the tree description.2 (See section 4.2.)

All four do the same processing of the tree description and are equivalent in
effect.
2.1 Basic tree description
A tree description consists of a set of nodes enclosed within parentheses. The

parentheses may be nested according to the tree structure. Whenever you key a
closing parenthesis ')', the matching opening parenthesis will be selected briefly.
Similarly, when you key an opening parenthesis '(', any matching closing paren-
thesis will be selected briefly. (If you have selected the Settings menu item / Draw
tree as you type option, the closing parenthesis is inserted automatically when you
key an opening parenthesis.) This is to help you match nested opening and closing
parentheses. You can control how long the matching parenthesis is selected; see
section 4.4.
When keying a tree description, you can force a new line to occur by pressing

the Enter key. You can also enter spaces and even tabs.
Here are three examples of how to key trees.
When you key what is in (2), it shows up as in (3).
(2) (((un)(lock))(able))

(3) un lock ableun lock ableun lock able

And if you key what is in (4)
(4) ((\1)(((p<in>ag) (–arál)) (an)))

it will produce what is in (5)
(5) p in ag –arál anp in ag –arál an

In example (4), notice that the infix material is indicated by typing an opening
wedge ‘<’, the infix form, and then a closing wedge ‘>.’ The node level of the infix

2When you key an opening parenthesis, it also automatically inserts a space and a closing paren-
thesis. Also, when you key an opening wedge ‘<’, it automatically inserts a closing wedge ‘>’.
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is indicated by the (\1) portion which we call an infix index. We use a backslash
followed by a 1 (one) to indicate the first infix in the tree (from left-to-right); (\2)
to indicate the second infix, etc.3 The backslash is used to avoid the ambiguity that
occurs when a font uses the same glyph for both the digit 1 and a lower case l.
The description in example (6) has two infixes in it and produces what is given

in example (7).
(6) ((\1) ((g<in>) ((pí-)((\2) ((p<in>a-)((m-)(ulod)))))))

(7) g in pí- p in a- m- ulodg in pí- p in a- m- ulod

You may set font and color information for the lexical items. See section 3.3.
When you do, the font and color will show in the description pane as well as in
the drawn tree.
2.2 Handling parentheses
If you need to put an opening or closing parenthesis in your tree, quote the

parenthesis by using a backslash immediately before it. Similarly, if you need to
put an opening or closing wedge in your tree, quote the wedge by using a backslash
immediately before it.
2.3 Restarting a tree
Sometimes you may decide that you want to just start all over when keying a

tree description. To do so, click on the Tree menu item and then Erase Description;
Start All Over. Whatever you have as your tree description will be removed and
replaced with the standard initial “((a)(b))” description.

3 Formating a tree
You can adjust the positioning of the tree and its nodes as well as choose the

fonts, sizes, and colors for the lexical forms. You can also set a background color
and determine the color and thickness of the lines in the trees.
All of these parameters are available on the Format menu item.
3A maximum of nine infixes are allowed.
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Please note that these settings are associated with each individual tree diagram.
Thus, you can set them to make a given tree diagram look its best.
3.1 Use dashed lines for split infixed base
The first item under the main Format menu item is Use dashed lines for split

infixed base. When this has a check mark before it, the horizontal and vertical
lines connecting the infixed base's before and after portions will be drawn using
dashed lines. For example, the description in example (8) will appear as in example
(9).
(8) ((\1)((p<in>a-)((m-)(ulod))))

(9) p in a- m- ulodp in a- m- ulod

3.2 Draw a tree right-to-left
The second item under the main Format menu item is Draw tree right-to-left.

When this has a check mark before it, the tree will be drawn from right-to-left.
3.3 Setting the font and color information
The next portion of the main Format menu item is for setting font and color

information for the lexical material.
When you select this menu item, it brings up a dialog box showing font family,

style, size and color options. The set of style options shown depends on what
styles the selected font has. So if the font only has “Regular,” then only Regular
will appear in the list of styles.
If you click in the Font list, then you can key a letter and it will go to the first

font name that begins with that letter.
To get the color chooser, click on the drop-down box in the lower left portion of

the dialog. It will look something like what is in (10).
(10)
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You can click on the color you want or you can click on the “Custom Color” link.
Doing so gives you what is in (11).
(11)

If you click on the Web tab, you can key in a code for the color. A list of color
names, their color, and the code can be found at https://www.w3schools.com/
cssref/css_colors.asp.
When you click on the main dialog's OK button, the tree description and tree

diagram will reflect the new font and color information.
3.4 Set keyboards
The next item under the main Format menu item is Set keyboards. Currently, this

is fully available on Windows and mostly available on macOS.4 When you select
this menu item, it brings up a dialog that looks like what is in (12).
(12)

You can control which keyboard is to be used with the various kinds of items in
the tree description. Click on the drop-down arrow to select one of the available
keyboards on your computer.
Note that whenever you move or copy a DiagSap description file from one com-

puter to another, you will need to manually set each keyboard before they will be
in effect.

4On macOS, Keyman keyboards are handled as a unit. That is, if you have two or more of
them, you will need to select the Keyman option with the dialog shown in (12). LingTree will use
whichever is the currently selected Keyman keyboard. This is an issue with macOS.

https://www.w3schools.com/cssref/css_colors.asp
https://www.w3schools.com/cssref/css_colors.asp
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3.5 Tree spacing parameters
The fourth item in the main Format menu item is Tree spacing parameters. When

you select this menu item, it brings up a dialog that looks like what is in (13).
(13)

Each row has a description of the parameter and a box to key a numerical value.
You can use negative numbers, if necessary.
3.6 Background and line parameters
The second from last item in the main Format menu item is Tree spacing param-

eters. When you select this menu item, it brings up a dialog that looks like what
is in (14).
(14)

You can set the color of the tree background and the width and color of the lines.
3.7 Saving format information for use with new tree diagrams
The last item in the main Format menu item is Save the current tree parameters

to use for new tree diagrams. When you select this menu item, the set of tree for-
matting values used for the current tree are remembered for any new tree diagrams
in the future.
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4 User convenience options
The Settings menu item has several options you can use to (hopefully) improve

your experience with using DiagSap. These are described below along with one
useful item under the Help menu.
Please note that these settings are associated with the DiagSap program on your

computer. Once you set them, they will be used each time you use DiagSap (until
you change them, of course).
4.1 Font size for tree description symbols
The first item under the main Settings menu item is Font size for tree description

symbols. This lets you set the font size for the symbols used in a tree description,
that is (, ), <, >, \1, \2, etc. The motivation for this is that some very high
resolution screens may make it a bit difficult to see these or, alternatively, they
may appear quite large in comparison to the other material in a tree description.
So you can change their size.
4.2 Draw the tree as you type
The second item under the main Settings menu item is Draw tree as you type.

When this menu item has a check mark before it, each time you change or edit
something in the tree description, DiagSap will redraw the tree diagram.
When using this mode, whenever you key an opening parenthesis, DiagSap will

automatically insert a space, an “a” and a closing parenthesis. The idea is to help
you keep opening and closing parentheses matched. It will also automatically
insert a closing wedge whenever you key an opening wedge.
Furthermore, if you key an opening parenthesis after the initial opening paren-

thesis or before the final parenthesis, DiagSap will also insert additional parenthe-
ses to keep the tree in its correct shape. This is to help you build the tree one level
at a time. For example, suppose you are creating a tree for one possible reading of
the word “unlockable.” You begin with a new tree and change the “a” and “b” to
“lock” and “able,“ respectively. It will look like what is shown in example (15).
(15)

If you then place the cursor after the initial opening parenthesis and type an open-
ing parenthesis, it will look like what is in example (16).
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(16)

You would replace the “a” with “un.”
Alternatively, you could begin with a new tree and change the “a” and “b” to

“un” and “lock,” respectively, so it would look like example (17).
(17)

If you then place the cursor just before the final opening parenthesis and type an
opening parenthesis, it will look like what is in example (18).
(18)

You would replace the “a” with “able.”
Sometimes the automatic drawing of the tree diagramwill cause an error message

to appear where the tree diagram normally shows; for example, if you have deleted
a parenthesis and no longer have a matching opening or closing one, then there
will be a message about a missing opening or closing parenthesis. As soon as the
tree description is well-formed, the tree diagram will appear.
4.3 Show matching parenthesis with arrow keys
As mentioned in section 2.1, when you key a parenthesis, DiagSap will tem-

porarily select the matching parenthesis to help you see the nested structure of the
description. There are times, however, when you need to see matching parentheses
and it would be nice if you did not have to delete a parenthesis and immediately
re-key it. For this reason, there is the third item under the main Settings menu
item: Show matching parenthesis with arrow keys. When this is checked, when-
ever you use an arrow key to cross over a parenthesis in the description, DiagSap
will temporarily select the parenthesis that matches the one crossed over.
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Besides using this menu option, you can also use the toolbar button shown in
(19).
(19) Show matching with arrows Do not show matching with arrows

4.4 Delay to use when showing matching parentheses
The fourth item under the main Settings menu item is Delay to use when showing

matching parentheses. The default delay is 750 milliseconds (i.e., three quarters
of a second). Depending on your typing speed, you may want to change this value.
Use this menu item to change the delay value to be shorter or longer. The shortest
allowed value is 125 milliseconds (i.e., one eighth of a second) and the longest
value allowed is 4000 milliseconds (i.e., 4 seconds).
4.5 Change the interface language
You can set the user interface language by using the Settings / Change the in-

terface language menu item. This brings up a dialog box showing the current
interface language in a drop down chooser. Click on the chooser's drop down but-
ton to see other interface language choices. The choices given use the name of the
language in the current interface language (so if the current interface language is
English, then it will show “Spanish” as an option; if the current interface language
is Spanish, it will show English as “inglés”).
The current version has English, some French and a rough, most likely often inac-

curate version of Spanish. Any corrections to the Spanish or French are welcome.
4.6 Quick Reference Guide
The main Help menu item has a Quick Reference Guide item. When you select

this item, it brings up a dialog box containing a list of the special symbols you can
key to get a particular result. You can position and/or resize this dialog so that you
can see it while also keying a tree description. That is, unlike most dialog boxes,
you do not have to close this dialog box before you can continue working. It will
stay open until you close it.

5 Saving the tree
While the resulting tree looks nice within the DiagSap program, what one usually

wants to do is to embed the tree diagram in some other document. DiagSap allows
you to save the tree in up to two formats:

• A Portable Network Graphics (*.png) file.
• Scalable Vector Graphics format (*.svg) file.
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You select which of these formats you wish to save by clicking on the File menu
item and then clicking on the Save tree as .png and/or Save tree as .svg items.
Besides using these menu options, you can also use the toolbar buttons shown in

(20) and (21).
(20) Save tree as .png Do not save tree as .png

(21) Save tree as .svg Do not save tree as .svg

You merely check the formats you wish to use. DiagSap will produce a file with
the given extension for each checked format. The file name (i.e., the part before
the extension) is the same for all of them.
In addition, you will find a file with an extension of ".diagsap" which contains

information for DiagSap to draw the tree. Do not edit this file. This has all the
information about the tree description that DiagSap uses.
Note that once you set these Save Formats, they stay in effect for all ensuing

trees you build.
Of these two formats, we highly recommend that you use the Scalable Vector

Graphics format (*.svg) whenever possible. This is because SVG format will always
look nice in a web browser or a PDF file, no matter how large the user makes the
page appear.
Another reason for using the SVG format is that if you find that DiagSap cannot

do everything you need for a particular tree diagram, you can produce the SVG
form and then use a tool like InkScape to do the rest. See https://inkscape.org/
en/ for more on InkScape.
If you do find yourself in a situation where you absolutely must have a pure

graphics image file and the Portable Network Graphics (*.png) form is not accept-
able, you can use various tools to convert your PNG file to some other graphics
image format. Example (22) lists some possibilities.
(22) Operating System Tool Potential formats

Windows Paint .bmp, .jpg, .gif, .tif
Mac OS X Preview .jpeg, .tiff
Linux Image Viewer .bmp, .jpeg, .gif, .tiff

In addition, there is the XnConvert program available at https://www.xnview.com/
en/xnconvert/. It runs on all three operating systems and can convert to many dif-
ferent image formats.

https://inkscape.org/en/
https://inkscape.org/en/
https://www.xnview.com/en/xnconvert/
https://www.xnview.com/en/xnconvert/
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6 Error messages
Whenever you process a tree description, if DiagSap notices any error in the de-

scription, it will show the error message in the same place where the tree diagram
usually appears. The message tries to indicate what the problem is and where it
was found (in terms of line number and character position). It also shows where in
the tree description the error was found. While these messages are intended to be
helpful, sometimes it may be the case that what needs to be done to fix the error
is not necessarily what the message implies will fix it.
For example, when the message is about a missing closing parenthesis, the mes-

sage actually indicates the innermost place where the outer parentheses match. So
it may not be the best place to insert a closing parenthesis; but, on the other hand,
it may work just fine. You may want to use the arrow keys to find the best place
to fix the problem (see section 4.3).
Another thing to note is that for longer, more complicated tree descriptions, it

may take a 2-3 times longer for the tree drawing process to happen if it finds an
error.
Example (23) lists the error types DiagSap reports along with a brief description

of what the error type might mean.
(23) Error Type Meaning

Missing closing parenthesis At least one closing parenthesis is missing.
Missing closing wedge A closing wedge is missing.
Missing constituent There is a node but it does not have both a

left and a right portion; it needs another
portion (enclosed within parentheses).

Missing constituent on the
right

There is a node that has a left portion, but
not a right portion; it needs a right portion
(enclosed within parentheses).

Missing content Some lexical material was expected but not
found.

Missing content and
closing parenthesis

Some lexical material was expected but not
found. In addition, there should be a
closing parenthesis after that content.

Missing opening
parenthesis

An opening parenthesis needs to be
inserted.

Missing opening wedges An opening wedge needs to be inserted.
Syntax error in description Perhaps obviously, this indicates some kind

of error, but DiagSap failed to identify it.
Look at where it was found and see if you
can guess what might be wrong.

The infix "xyz" has no
matching index.

The infix (indicated by what is inside the
quotes) does not have a corresponding infix
index (which is indicated by (\1), (\2),
etc.)
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The infix index "xyz"
appears more than once. It
must only be there one
time.

The same infix index occurs more than
once. E.g., there are two instances of (\1).

The infix index "xyz" has
no matching infix. This is
not allowed; change its
number or add an infix
base.

An infix index was found that does not have
a corresponding infix.

There is content after a
completed tree

A “completed tree” means that there is a
matching closing parenthesis for the first
opening parenthesis. This error indicates
that some content or nodes occur after the
closing parenthesis which matches the first
opening parenthesis. It may be that you
need another opening parenthesis before
the first opening parenthesis or maybe some
content was keyed in the wrong place at the
end.

Too many closing
parentheses

A closing parenthesis was found that does
not have a matching opening parenthesis.

Two consecutive nodes
found between "xyz" and
"abc". This is not allowed;
change one to lexical
material, an infix index, or
an infix base.

Since every node is binary, one part must
be lexical material, an infix, or an infix
index and the other part must be the same
or a node. DiagSap found that there were
two nodes one after the other.

7 Known problems
The following items are known to be less than desirable with this version of

DiagSap:

• The splitter bar between the description and the drawing may change between
invocations of DiagSap.

• When showing matching parentheses while using arrow keys (see section 4.3),
if you type several arrow keys quickly, the cursor caret may not be where you
expect it. Either
• turn off the show matching parentheses with the arrow keys option;
• set the delay to be shorter (see section 4.4); or
• wait for the matching parenthesis to show before pressing the next arrow key.

• Undo and redo do not always work as expected.
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• On macOS: if you double click a tree description file in Finder, then DiagSap
will open the last opened file, not the one you clicked on. This is due to a
communication problem between the macOS operating system and the Java
language DiagSap is written in.

• When you move a DiagSap file from one computer to another, you may well
need to reset the keyboards manually. This is because the keyboard settings
may be different on the two machines.

8 Support
If you have any questions with DiagSap or find bugs in it, please send an email to

lingtree_support@sil.org or go to the DiagSap web site at https://software.sil.org/
lingtree/.

mailto:lingtree_support@sil.org
https://software.sil.org/lingtree/
https://software.sil.org/lingtree/
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